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What is the CALL Public DB?

• A collection of army-related articles, theses, monographs, 
papers, historical documents, and other resources that are 
unclassified and releasable to and available to the general 
public without restriction.

• A structured, hierarchical repository that is patterned after 
an office filing system, including file rooms, file cabinets, 
file drawers, file folders, and documents.

• A repository that can be searched either by drilling down 
through levels of hierarchy or by submitting queries, using 
a powerful search and retrieval software (Convera 
RetrievalWare).

• A product and responsibility of the Research Division of the 
Center for Army Lessons Learned, Fort Leavenworth, 
Kansas.



How do I get to the 
CALL Public DB?

CALL Homepage:
http://call.army.mil/
Click on CALL Databases **

CALL Databases Page:
http://call.army.mil/calldb.htm
Click on Public Database *

CALL Public Database Page:
https://calldbp.leavenworth.army.mil/calldb.html
Click on CALL Public Database *
See next slide for full-size view.

*

*

Expect a “Security Alert” – click Yes

http://call.army.mil/
http://call.army.mil/calldb.htm
https://calldbp.leavenworth.army.mil/calldb.html


What is required to effectively 
use the CALL Public DB?

Note carefully these 
requirements.

Note: Most new 
users will need to 
download the TIF 

Image Viewer.

Click here to proceed directly to the CALL Public DB.



CALL Public DB

Databases View

} Ignore these things.

} Start here.

What do I do now?
Option #1: Drill down to browse the contents of Filerooms 
Option #2: Select Filerooms to search, then click on Query

Databases Button
Note: This is the 

first of 4 
Buttons.



When should I drill down?

• When you are unfamiliar with 
and have the time to browse 
the contents of a fileroom.

• When you know where to find 
a particular file (e.g. a specific 
Military Review article). 

Recommendation: The query should be your principal 
means of finding documents, not drilling down.



Levels of Hierarchy

3 Filerooms

23 File Cabinets

222 File Drawers

File Folders

Documents

Drill-Down

Fileroom > Cabinet > Drawer > Folder > Document



Drilling Down

4>

1>

2>

3>
5>

Fileroom > Cabinet > Drawer > Folder > Document



Overview of the Contents
Filerooms and File Cabinets.

Ignore the 
Inboxes and 

Wastebaskets.



CALL Public DB Fileroom Highlights

Combined Arms Research Library
• Command and General Staff College (CGSC)

– Student Master of Military Arts and Sciences (MMAS) 
theses, 1964-present (the work of about 1,250 
students)

• School for Advance Military Studies (SAMS)
– Student Monographs, 1984-present (the work of about 

1,000 students)
• Training and Doctrine Command (TRADOC)

– Historical Monograph Series (5 series volumes; located 
in FM 100-5 and Related Literature file cabinet)

See also resources on the CARL Website
http://www-cgsc.army.mil/carl/resources/

http://www-cgsc.army.mil/carl/resources/


CALL Public DB Fileroom Highlights

Military History Institute

• Selected U.S. military history documents, 
from 1917-1991

• Selected Officer Career History Interview 
Transcripts

• Selected Obsolete Army Field Manuals

This fileroom consists of resources received from  the Military 
History Institute, Carlisle Barracks, Pennsylvania.  Also see their 

website for other digitized historical materials:  
http://carlisle-www.army.mil/usamhi/DL/index.htm

http://carlisle-www.army.mil/usamhi/DL/index.htm


CALL Public DB Fileroom Highlights

Military Review English 
Language

All issues of Military Review, a periodical 
publication of the Command and General 

Staff College, Fort Leavenworth, 
from 1922-2004.

For the latest issue(s), see also the 
Military Review Home Page:  

http://www-cgsc.army.mil/milrev/

http://www-cgsc.army.mil/milrev/


Before you Search . . .

First Check the Boxes for the 
Libraries You Want To Search



Query View

Simple Search on exact phrase “consequence management”

Query Button

The libraries/filerooms that
you have chosen to search. You 

cannot search without having 
selected a library or libraries 
under the Databases button.

Note: The default is set for a Simple Query. You can do a more 
sophisticated search by clicking on the Advanced button.

Note: More will follow on Mode and Style selections on later slides.



Simple Search Results

Note: #1 and #5 represent different pages within the same 
document. Word, PowerPoint, and PDF files always report pg 1, 

while separate files for each page characterize image files. Each of 
the above 5 files are image files.



Advanced Searches

Click here to get to the Advanced 
Search.



CALL Public DB
Advanced Searches

Your Options:
• Style

– Narrow (fewer hits)
– Average 
– Broad

– Power Search
– With Concept 

Searches

• Mode 
– Boolean (exact)
– Pattern (fuzzy)
– Concept (semantic)

• Expansion
– 1. Exact Matches 
– 2. Simple Variations
– 3. Most Strongly Related 

Concepts
– 4. Strongly Related Concepts

– 5. Weakly Related Concepts

Recommended settings in Blue.

Red: Use only with Concept Searches.



CALL Public DB
Search Mode

Your Most Important Choice
Boolean
– An search that looks exactly for the words in your clue or an exact phrase if 

enclosed in quotation marks.
– Allows for use of Boolean operators (and, or, not) and proximity operators.
– Best quick search when you want a limited number of hits.

Pattern
– A search that looks not only for the exact words in your clue, but also other 

words that looks something like those words.
– Best search when you are not sure of the spelling of a word or if you are 

searching against text read by Optical Character Recognition (OCR).  We 
The DB has much OCR text.  

– Produces many more hits than a Boolean Search, but ranks hits by several 
criteria.

– Slower than a Boolean search.

Concept
– A semantic or meanings search.
– Searches not only for the exact words in your clue, but also other words 

that have similar meanings.
– Best search for ranking and putting best hits at the top of your results list.



CALL Public DB
Boolean Search

The exact phrase “Army Transformation” and the acronym BCT
must both appear in the same file.  This would be the green area.

CALL Public DB
Boolean “AND” Search

All Boolean searches can be done as either 
Simple or Advanced searches.



CALL Public DB
Results of Boolean “AND” Search

The icons tell you that these are Word and PDF files.



CALL Public DB
Boolean “OR” Search

This search looks for the either the exact phrase “force 
protection” or the word antiterrorism.  The results will include

the blue, green and yellow areas.



CALL Public DB
Results of Boolean “OR” Search

The icons tell you that these are 
PDF, image, and Word files.



CALL Public DB
Boolean Proximity Search

The exact term “Army Transformation” and the acronym BCT 
must be within 50 words of each other in at least one place in 
the file. The asterisk in front of BCT serves as a wild card, so

this search will also look for IBCT or SBCT.



CALL Public DB
Results of Proximity Search

The icons tell you that these are all PDF files.



CALL Public DB
Pattern Search

A fuzzy search on the four words.  Two of the words are misspelled,
but the search looks for words that are similar.

All Pattern searches can be done as either 
Simple or Advanced searches.

Note that Caribbean and relief are 
spelled incorrectly.



CALL Public DB
Results of a Pattern Search

The icons tell you that these are image and PDF files.

Ranking places best hits as determined by 
several criteria at the top of the results list.



CALL Public DB
Concept Search

By clicking on Power Query,
you can give added weight 

to certain meanings.

By Clicking on Refine Terms,
you can select the specific 

meanings of army and 
transformation that you want.



CALL Public DB
Results of a Concept Search



Advanced Searches
Search Templates

Drop-down Menu Choices:
All Fields: 43 files – not recommended for users
Short Template: 5 fields – recommended
Hierarchy Template:  5 fields – recommended



Advanced Searches
Search Templates: Examples

Search Mode should be Boolean for the following examples.

Looking for all MILITARY REVIEW articles in the year 2000.
Use Hierarchy template; File Drawer = 2000
114 hits on results list (Military Review fileroom)

MILITARY REVIEW articles with “transformation in the title.
Use Hierarchy or Short template; Subject = transformation
10 hits on results list (Military Review fileroom)

CGSC theses and SAMS monographs dealing with Army Transformation.
Use All Fields; keywords = “army transformation”
21 hits on results list (Combined Arms Research Library fileroom)
Note: only this fileroom uses the keywords field.



For more ideas on searching 
click on Help



CALL Public DB
Results View

Document Preview Space

Results List

Re-size Results List and Document Preview areas by 
clicking on the vertically-space marks to the left.

Preview
Next Document
On the Results

List.

Results Tab



Viewing Search Results
Clicking on Icons*

Word file PDF file Image file

You will need to
have Adobe Acrobat
to view these files.

You will also see
PowerPoint and

Excel icons.

You will need to
have the TIFFviewer to see
Tagged Image Format files.

Download viewers/readers from the CALL DB Requirements Page.



CALL Public DB File Formats

Portable Document Format (PDF)

< Image view

^ PDF view – click on 
PDF icon< Text view



Saving or Printing Files
TIFFs

To Save: Click on the floppy disk icon on the TIFF 
Image Viewer toolbar, then browse to select a location 

where you wish to save this page. *

* Note: You can also save this page as a 
PDF by clicking on the PDF icon on the 
toolbar (the second from the right.

To Print: Click on the printer icon on the toolbar.

If you are unable to view images, 
you will need to download the 

TIFF Image Viewer. 



Saving or Printing Files
PDFs

To Print: Click on the printer icon on the PDF toolbar.

To Save: Click on the floppy disk icon.



Saving or Printing Files
Microsoft Word

To Print: From the File menu, select Print.

To Save: From the File menu, select Save As…



Saving and Printing Files
ASCII Text

1) Select the desired text and copy (Ctrl C ; or select Copy from the Edit menu.
2) Open a Word or WordPerfect file and paste (Ctrl V ; or select Paste from the 

Edit menu.
3) Repeat the select, copy, and paste for other pages or excerpts.
4) Print from the Word file.

Warning: Optical Character Recognition (OCR)-generated text will 
include some or many errors.



Saving and Printing Files
ASCII Text

Note: You can also click on the 
Print button, which will bring up 

the window to the right. 

Note: You can print one 
document page, several, or all. 
Remember this print capability 

applies only to ASCII text, not to 
images.

Warning: Printing ASCII text by this means will often cut off a word or words on the right-hand side 
of each line. One way around this problem is to go to the Layout tab in the print window and change 

the orientation from Portrait to Landscape. Still, this will probably mean that one online page will 

print on three sheets of paper. See previous slide for an alternative or print the image.



Options

Some Suggested Settings

• Database Hierarchy Options
– Maximum Hierarchy Nodes … : 50

• Results List Options
– Number of Documents to Browse … : 25
– Show [eyes] if Document Has Already Been Viewed: check
– Summary Type: None [note other choices will slow the 

display of your results]
• Document View Options

– Document View Font Size: Small or Normal
– Number of Pages to Browse at a Time: 50

• Document Print Options
– Document Print Font Size: Small



Help
• Introduction
• Navigating the SmartSearch Interface
• Types of Queries
• Performing basic searches
• Performing specialized searches
• Viewing, Launching, and Printing Documents
• Using Categories, Profiles, and Experts  (not applicable)
• Using Multiple Languages  (not applicable)

Drill Down
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